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Preface
Acousto-optic modulators (AOMs) are an integral part of many mod-ern laser-based experiments. They are used for frequency shift-ing, amplitude modulation, and laser frequency stabilisation. TheMOGLabsQRF quad RF synthesizer provides a user-friendly devicethat can simultaneously control four AOMs at once, with direct outputof up to 2 W per channel.The wide frequency range (10 to 200MHz) is compatible with mostcommon AOMs, and it provides high-resolution frequency, amplitudeand phase control. The QRF provides analogue modulation of eachchannel with 70 kHz bandwidth, ergonomic front-panel controls, andethernet/USB interface. The included table mode allows generationof predefined time-dependent waveforms. The QRF is is single small(half-rack width) box which connects directly to AC mains power.As you delve into this manual you will uncover more and more capa-bility, but the microcontroller at the heart of the QRF allows softwareimprovements to add new features, so please check the MOGLabswebsite for updates, example code, and assistance.We hope that you enjoy using the QRF, and please let us know ifyou have any suggestions for improvement in the QRF or in thisdocument, so that we can make life in the lab better for all.
MOGLabs, Melbourne, Australiawww.moglabs.com
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Safety Precautions
Safe and effective use of this product is very important. Please readthe following safety information before attempting to operate. Alsoplease note several specific and unusual cautionary notes beforeusing the MOGLabs QRF, in addition to the safety precautions thatare standard for any electronic equipment.

CAUTION To ensure correct cooling airflow, the unit should not be oper-ated with cover removed.
WARNING High voltages are exposed internally, particularly around themains power inlet and internal power supply unit. The unitshould not be operated with cover removed.

NOTE The MOGLabs QRF is designed for use in scientific researchlaboratories. It should not be used for consumer or medicalapplications.
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Protection Features
The MOGLabs QRF includes a number of features to protect you andyour device.

Open/short circuit Each RF output should be connected to a 50 Ω load wherepossible. The high-power output can tolerate open-circuit,but should not be short-circuited.
Mains filter Protection against mains transients.
Temperature Several temperature sensors control the fan and will trigger ashutdown if the temperature exceeds a safe limit.
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RoHS Certification of
Conformance
MOG Laboratories Pty Ltd certifies that the MOGLabs Diode LaserController (Revision 3) is RoHS-5 compliant. MOG Laboratoriesnotes, however, that the product does not fall under the scope definedin RoHS Directive 2002/95/EC, and is not subject to compliance, inaccordance with DIRECTIVE 2002/95/EC Out of Scope; Electron-
ics related; Intended application is for Monitoring and Control or
Medical Instrumentation.MOG Laboratories Pty Ltd makes no claims or inferences of thecompliance status of its products if used other than for their intendedpurpose.
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Getting started

1. Connect to mains power using the supplied IEC cord.
2. Power on the device using the rocker switch on the rear.
3. Wait for the device to boot and the menu system (§2.2) to bedisplayed.
4. Set power limits for each channel using the Options menu.Devices are shipped with a 30 dBm limit that should be ad-justed as required. The power limits should be chosen to en-sure attached devices are not damaged by accidentally out-putting too much power.
5. Attach devices to the RF SMA connectors, which are nominally50 Ω loads. Under no circumstances should the RF output beshort circuited.
6. Switch on output using the LHS front-panel push-buttons. Chan-nels without attached loads should not be enabled.
7. Modulation inputs can be used to control the RF with an ana-log signal (chapter 4). Each channel has an associated SMAinput that accepts ±1 V.
8. External control of the signal is achieved with TTL SMA inputs,which can be used to generate sharp pulses (§4.5).

Host connection The recommended mode of operation is using the Windows™ hostapplication (chapter 3) which provides a simple interface for con-trolling device functionality. Instructions for connecting via ethernetand USB are provided in Appendix D.
ix
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1. Introduction

The MOGLabs QRF consists of an AD9959, which provides four in-dependent direct digital synthesizer (DDS) sources, and a 2 W am-plifier for each channel. The frequency, amplitude and phase ofeach output is software-controlled via a microcontroller, which canbe adjusted in real-time using the front-panel control knobs, or viaa scripting language over ethernet or USB. The RF parameters canbe defined in a lookup table (loaded via ethernet or USB) to enablecomplex sequences with fast transitions.The block diagram below shows the key components. A microcon-troller programs the DDS, which generates RF output that is low-passfiltered, pre-amplified, and then further amplified with a custom GaNhybrid high-power output stage (QRF241 only).The microcontroller provides a front-panel display with rotary en-coders (knobs) and push-buttons, as well as external interfaces overTCP/IP and USB communications.
Front Panel Display

Micro
controller

ADC + �lter
(1 per channel)

Ethernet
10/100

USB

RF OUT

4x MOD IN

RF on/o�

RAM table 
memory

DDS
RF ampli�er

Local
Clock

External
Reference

RF switchFilter

Figure 1.1: Block diagram of major components in the QRF.
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2 Chapter 1. Introduction

The device allows analogue modulation through analogue-to-digitalconverters (ADCs) with anti-aliasing filters. When modulation is en-abled, the microcontroller reads the value of the modulation signaland uses that value to adjust the DDS frequency, power and/or phase.The QRF includes memory for storing complex waveform sequences,where each step in the sequence defines the frequency, power, phaseand duration of that step. This capability can be accessed via eitherTCPIP or USB communications. See Chapter D for information oncommunications options and setup.Once communications are established, the QRF is controlled withsimple text commands. The commands can be very basic, for ex-ample to define the frequency or power, or they can define complexdynamic sequences. Appendix C provides a summary of the availablecommands.
1.1 Operating modesThe QRF can be used at varying levels of complexity, as either a free-running RF source or to follow pre-determined instructions defined ina table. The modes of operation are outlined below, and the currentoperational mode of each channel can be individually set using the

MODE command.
NSB: Basic mode Default state on power-up. In this mode, each channel acts as asimple single-tone RF source. The frequency and power of the signalcan be controlled via the front panel, using simple instructions overthe computer interface (e.g. FREQ or POW), or using the modulationinputs. Basic mode is convenient for driving AOMs and other single-frequency devices, with the flexibility of modulation.



1.2 Feature compatibility 3
NSA: Advanced mode Advanced mode provides direct user-control of the DDS and its in-ternal registers via the DDS command. Direct programming of eachDDS is complex and not necessary for most applications; it requirescareful reference to the AD9959 datasheet and manual calculation ofthe hardware registers.
TSB: Simple table modeIn table mode, the RF parameters are automatically sequenced bythe microcontroller using a table stored in SDRAM. The table entriesare defined by simple text commands from the host computer whichdefine the RF frequency, amplitude, phase as detailed in chapter 5.The minimum duration of a TSB entry is 5µs and each table cancomprise up to 8191 instructions.
1.2 Feature compatibilityThe QRF provides a wide range of functionality, but not all featuresare compatible with each other. The following table summariseswhich features can be used in which modes.

NSB NSA TSBFront-panel controls 3 7 7External modulation (AM/FM/PM) 3 7 7PID control 3 7 7Direct TTL on/off control 3 3 7Direct DDS control 7 3 7Autonomous execution 7 7 3External TTL trigger 7 7 3

Table 1.1: Summary of feature compatibility
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2. Connections and controls

2.1 Front panel controls

4 Ch. RF Sythesizer

Ch. 1 Ch. 2 Ch. 3 Ch. 4

Figure 2.1: Front-panel layout of QRF devices.
The front-panel includes an interactive menu system for displayingthe device state and controlling its settings. Each channel has anindividual on/off button on the left-hand side, and an associatedmulticolour status LED that indicates the current output state of thechannel as shown in the following table.

Colour DDS active AmplifiersOff 7 7Green 3 3Yellow 3 7Blue 7 3Purple Debug modeRed Error state

5



6 Chapter 2. Connections and controls

2.2 Menu systemThe main menu (Figure 2.2) shows the current mode and statusof each channel. In basic (NSB) mode, the current frequency andpower of each channel is displayed, as well as any active modulation.Pressing the OK button with a channel selected will open the sub-menu to adjust settings for that channel (Figure 2.3).The buttons on the right-hand side navigate through the menu struc-ture and the encoder wheel is used to edit values. The ∧ and ∨ keyschange between menu items, ← exits to the previous menu, and OKenters the selected menu or activates the selected command.

Figure 2.2: The main menu shows the current state of each channel. CH1and CH2 are in table mode, with the number of entries in the table shown.CH3 and CH4 are in basic mode.

Figure 2.3: The basic parameters of each channel can be edited directly.Turning the encoder wheel modifies the selected digit of the current value(left) as indicated by the arrow. Pressing the encoder wheel changes to
digit select mode (right), allowing the selected digit to be changed byturning the encoder.



2.2 Menu system 7
The color of each menu item represents its purpose, as listed below.

White Static value, displayed for diagnostic purposes.
Yellow Adjustable value, modified using the encoder wheel.

Orange Currently selected channel.
Blue Submenu, entered with the OK button.

Green Command, executed by the OK button.
When an editable (yellow) value is selected, turning the encoderwheel changes the value of the selected digit as identified by thearrow and red text. To change the digit of interest, either use the <or > buttons or press the encoder wheel to change to digit selection
mode. In this mode, the currently selected digit is shown on a blackbackground, and is changed by turning the encoder wheel. Pressingthe encoder again returns to value modification mode.The options menu (Figure 2.4) allows the device configuration to beadjusted, such as the power limit of each channel (see also the LIMcommand). The ethernet settings of the device can also be set usingthis interface, including the static IP address of the device. When inuse, the network status is displayed on the display footer, and onceconnected displays the current IP address.Note that the “Restart ethernet” command must be used beforechanges in the ethernet menu will take effect.

Figure 2.4: The options menu allows configuration of various settings,such as the maximum output power (left) and ethernet options (right).
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The overall brightness of the display can be set with the contrastvalue in the Options menu. The display also includes a sleep timerthat dims the display if it hasn’t received input in a given period oftime. This can be disabled by setting the sleep timer value to 0.
2.3 Rear panel controls and connections

RF 1 RF 2

MOD 1 MOD 2 MOD 3 MOD 4

ON/OFF 1 ON/OFF 2 ON/OFF 3 ON/OFF 4

RF 3 RF 4

REF CLK

80  264 Vac
47  63 Hz Serial No:

Model:

Made in Australia

Figure 2.5: QRF rear panel layout.
IEC power in The QRF is compatible with all standard AC power systems, from 90to 264 V and 47 to 63Hz.

Fan The QRF has five temperature-controlled fans directing air flow overthe RF power amplifiers, exhausting through the rear vent. Ensurethat the vent does not become blocked.
RF SMA connectors for the primary RF outputs. Nominally connected toa 50Ω load, must not be short-circuited.

MOD Each channel has an associated SMA analog input, for AM/FM/PM/PIDapplications (see chapter 4).
ON/OFF SMA digital inputs for controlling the RF switch (see §4.5), compat-ible with both 3.3 V and 5 V logic. Also used for external triggeringin table mode.



2.4 Internal DIP switches 9
CLK IN The QRF can be synchronised to a high-performance external clockinput via this SMA connector. The input is 50Ω terminated, and theprovided 25 MHz reference must be between 0 and +5dBm.

RJ45/USB-A Ethernet (TCP/IP 10/100 Mb/s) and USB communications jacks.
2.4 Internal DIP switchesFour DIP switches are provided to assist in diagnosis and recoveryof the QRF units. They should all be left in default configuration (setto OFF) for regular operation.

WARNING There is potential for exposure to high voltages inside the QRF. Takecare around the power supply and ensure that objects, particularlyelectrically conducting objects, do not enter the unit.
CAUTION The cover should be replaced before powering on to ensure properairflow and cooling.

Function
DIP 1 Enter firmware update mode
DIP 2 Disable amplifiers
DIP 3 Use factory network settings
DIP 4 Initiate factory reset
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3. MOGRF host software

The mogrf software package provides a simple user interface to thebasic behaviour of QRF devices, with the ability to issue commands,run scripts, control tables, and apply firmware updates. This is thesame software used to control ARF/XRF devices.
Please note: It may be necessary to install a firmware update (seeAppendix B) to use the software described in this section.

3.1 Device discoveryUpon starting the application, a device discoverer (Figure 3.1) isinitiated. This program scans the COM ports of the host computerlooking for a QRF device, and then scans the local network subnet.Starting the application is then as simple as selecting the device andclicking Connect. If your device is not listed, recheck your connectionand network settings.If the network and/or firewall blocks device discovery, enter the IPaddress of the unit in the Device address box directly.

Figure 3.1: Example of the Device discoverer window, showing that onenetworked device was detected.
11



12 Chapter 3. MOGRF host software

3.2 Device commanderThe Device commander is an interactive terminal for issuing com-mands and queries to your QRF device and displaying the result(Figure 3.2). The accepted commands and their functions are listedin Appendix C. Type statements into the Command box and exe-cute them by pressing the ENTER key or clicking Send. The windowcontains a history of recently executed commands.

Figure 3.2: The Device commander window, which permits the executionof individual instructions or of text files containing scripts.
Scripts are ASCII text files where each line corresponds to a com-mand to be executed (see Appendix E). Clicking Run script triggersstepwise execution of such a script, where the success of each state-ment is checked before executing the subsequent line. If an erroroccurs, execution of the script is aborted and an error message isdisplayed.If the device is restarted or the connection is lost, clicking Reconnectwill attempt to reestablish communication.



3.3 MOGRF main window 13
3.3 MOGRF main windowThe main window of mogrf is shown below. The channels are dis-played side-by-side, with information and controls that depend onthe current operational mode of each channel.

Figure 3.3: The main window of mogrf, showing CH1 and CH2 are in basicmode, and CH3 and CH4 are in table mode. Different options are presentedin different operating modes.
Each channel is controlled individually as follows:• The operational mode of the channel can be changed by click-ing on the coloured box.• In basic mode the frequency, amplitude and phase are dis-played. Changing the value immediately updates the output.• In table mode, buttons are provided to trigger specific func-tionality.• Checkboxes control the RF switch (signal), RF amplifiers (power)or both (241-series only).
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3.3.1 File menu

Device command Starts the Device commander (§3.2) for interactive execution of in-structions to control the device.
Upload firmware Starts the firmware update application to upload and install up-dates on the device. The procedure for applying firmware updatesis described in detail in Appendix B.

3.3.2 Settings menu

Ethernet Allows configuration of network connection settings (IP address, mask,gateway and port). Particularly useful for configuring the networksettings over USB. Note that changing the Static IP only has aneffect if DHCP is disabled, or if DHCP name resolution fails.

Figure 3.4: Ethernet configuration interface.
Note that changing the ethernet settings will require the applicationto be restarted, and may also require the device to be rebooted. Theport should be unchanged at 7802 to ensure that the mogrf suite ofprograms can continue to communicate with the device.

Modulation The QRF supports a variety of modulation options as detailed inchapter 4. For each channel, the individual modulation types can beenabled/disabled and their gains adjusted using this dialog window(Figure 3.5).
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Figure 3.5: Use the Modulation dialog in the mogrf application to changethe modulation settings for each channel
Each channel can have a primary and secondary modulation enabled(§4.3), which use the associated physical modulation input mapping.The gain can be set using the slider or by entering a value directly.Negative gain is specified by ticking the Invert check box. Similarly,PID can be enabled on the primary channel (§4.4) and the gainsadjusted in the same way.
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4. External modulation

The QRF supports external modulation of the RF in NSB mode throughthe modulation input SMA connectors on the back-panel. Frequency,amplitude and phase modulation of the RF are supported.
WARNING: The modulation inputs are nominally ±1V, and can be permanentlydamaged by applying higher voltages. Disconnected inputs are floating and cancause unexpected results when modulation is enabled.

4.1 Operational principleModulation is performed by digitising the analogue input signal,which is then multiplied by the modulation gain and added to the in-ternal control value associated with the particular modulation mode(“frequency tuning word” for frequency, “amplitude scale factor” forpower or “phase offset word” for phase). Limits are applied to ensurethat the value remains within the bounds.The ADC has 12-bit resolution (±1 V range), has 2nd-order anti-aliasing filters at 100 kHz and a measured 3-dB bandwidth of 70 kHz.Modulation is enabled/disabled with the MOD command1. For exam-ple, to enable AM on channel 1, use the command MOD,1,AM,ON.Note than no amplitude-compensation is applied in FM mode, sochanges in amplitude with frequency are expected in applicationsthat sweep the frequency by a large amount. Consult the test reportshipped with your QRF for an indication of the response curve, oruse dual-modulation with AM to maintain a desired output power.
Note that modulation is not available in table mode.

1The “MDN” command is a synonym for compatibility with other products.

17



18 Chapter 4. External modulation

4.2 Modulation gainThe modulation depth is controlled by the “gain” and is set usingthe GAIN command. Each channel has a separate gain control foreach modulation mode (amplitude, frequency or phase), which canbe negative to indicate that the modulation action is inverted.The gain can be specified with physical units, which corresponds tothe modulation produced for +1V input. For example, when +1V isapplied to the associated modulation input, GAIN,1,FREQ,-10MHz willshift the output frequency down by 10 MHz and GAIN,1,PH,180degwill invert the phase. Alternatively the gain can also be specifiedas a signed 32-bit integer in hexadecimal with negative values rep-resented using two’s complement.The amplitude gain is represented as a percentage of full-scale am-plitude. Therefore a gain of 100% will bring the output to full powerat +1V input (as restricted by the channel’s power LIMIT). To pre-vent unexpected results, it is recommended to verify the modulationgain by disconnecting the load and checking the amplitude of theRF output on an oscilloscope with 50Ω termination.
4.3 Dual modulationThe QRF supports dedicating two modulation inputs to a single chan-nel in “dual modulation” mode, enabling applications such as simul-taneous AM and FM. In particular, this permits PID stabilisation todynamically correct for the frequency-dependence of an attachedload (such as the diffraction efficiency of an AOM).In order to use this mode, the physical modulation inputs on theback-panel must be mapped to the desired destination channel.Each channel can have assigned “primary” and “secondary” inputs,which can be reconfigured using the control application (Figure 3.5)or the MAPMOD command.
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Each physical input can only be used for one purpose at a time,so if an input is used for primary modulation on a channel, it can-not simultaneously be used for secondary modulation on a separatechannel. Furthermore, to prevent confusion it is recommended thatthe primary modulation channel remain assigned to the RF channelwith the same number.Once configured, the primary and secondary modulation inputs canthen be activated using the MOD command as shown in the examplebelow.# this example shows dual modulation on CH1# we configure the MOD1 input for FM and MOD2 for AM
MAPMOD,1,1,2

MOD,1,FM,AM# configure the modulation gains
GAIN,1,FM,10 MHz # 10 MHz/V
GAIN,1,AM,10% # 10% of full=scale amplitude

Listing 4.1: Demonstration of simultaneous AM+FM on CH1.

Figure 4.1: Example waveform (blue) showing a chirped pulse generatedwith the dual-modulation example by feeding a triangle wave (red) intoboth primary and secondary modulation inputs.
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The modulation mapping is stored in non-volatile memory, but it isstrongly recommended that any setup scripts explicitly include themodulation input mapping to prevent confusion.The active purpose of the modulation inputs can be verified usingthe MAPMOD command. For the example above CH1 uses both MOD1and MOD2 inputs, which are both presently active. Querying the MODcommand shows that these are being used for FM and AM respec-tively.
>> mapmod,1

<< 1 (ACTIVE), 2 (ACTIVE)

>> mod,1

<< FM, AM

Listing 4.2: Example verifying the modulation configuration of CH1.
There are several restrictions in dual-modulation mode:

• Simultaneous modulation of a single parameter is not permit-ted (e.g. two inputs both controlling FM of one channel).
• Mapping a second modulation input to the same modulationmode will override the first (e.g. attempting to assign twoinputs to CH1 primary).
• If a single modulation input is enabled for primary and sec-ondary modulation on different channels, the secondary mod-ulation will be disabled.
• PID can only performed on the primary modulation input.
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4.4 PID stabilisationIn addition to direct modulation, the QRF also provides PID controlloops which can be used in conjunction with an AOM to performintensity (also called noise eating) or frequency stabilisation of alaser. Each channel has an independent PID controller, which actsto drive an error signal provided to the modulation input towardszero by adjusting the frequency, power or phase as appropriate.

AN001: An application note is available from the MOGLabs website that describesPID control in more detail, and provides instructions for tuning the PID loop.
Upon activating the PID controller, the channel’s modulation input istreated as an error signal instead of a control voltage, and the ac-tion of the controller is to drive this signal towards zero. Locking toa non-zero value can be achieved with the PID,SETPOINT command.However, to make best use of the analog-to-digital converter’s dy-namic range, it is recommended to remove the set-point before digi-tisation using a signal conditioning circuit (Figure 4.2).
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Figure 4.2: Photodetector signal (magenta) and conditioned error signal(blue) before and after activating noise-eater functionality. The condition-ing board removes the DC offset and applies gain, improving sensitivityand ensuring the signal remains between ±1 V.
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A clamping circuit should be used to ensure that the signal fed intothe QRF does not exceed the ±1 V modulation input tolerance, asthis can damage the input ADCs.For convenience, MOGLabs produces a signal-conditioning board(B3122) available as an optional extra, which provides:
1. Manual offset adjustment using a potentiometer2. Analog offset subtraction (e.g. from DAC output)3. Variable analog gain4. Monitor outputs for both photodetector and error signals5. Output protection, to prevent exceeding ±1 V.

The error signal is then converted into a control value using thestandard PID function:
u(t) = Gkpe(t) + Gki

∫ t

0 e(τ)dτ + Gkd
de
dt ,where e(t) is the input error signal, u(t) is the feedback response,and G is the overall modulation gain. The gain constants kp, ki, kdare floating-point values in the range [0, 1] which tune the propor-tional, integral and differential responses respectively. Typical val-ues depend on the application, but reasonable starting values areoften kp = 0.1, ki = 0.01 and kd = 0.When optimising a PID control loop, it should be kept in mind that theachievable loop bandwidth is limited by the propagation delay of theentire signal processing chain, not just the modulation bandwidth.This includes the impulse response of the AOM, photodetector andsignal-processing electronics, as well as the QRF. Typical resultsachieved with standard AOMs are shown in the application note.
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4.5 TTL switchingA versatile feature of the QRF is the ability to switch the RF in re-sponse to an external input such as a tactile switch or a TTL triggerfor device synchronisation. The switching bypasses the microcon-troller, enabling very low latency switching to be achieved (Fig-ure 4.3).

Figure 4.3: Example of pulse generation using the ON/OFF input, showinga response time of < 40 ns. Red is the TTL signal; blue is the RF signal.
Each channel has one TTL input on the rear panel labelled ON/OFF.In basic (NSB) mode, pulling the TTL LOW will rapidly disable theRF switch, and returning it HIGH will reenable the switch. In tablemode it is used as a hardware trigger for synchronising the tableexecution.
Note: Digital inputs are pulled high, meaning that a disconnectedinput pin is equivalent to supplying a TTL high to that input.
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5. Table mode

Table mode performs sequential execution of up to 8191 instruc-tions with precise timing. This enables generation of complicatedpulse sequences, custom envelope shapes, and automated control ofexperiment sequences through digital I/O.
5.1 Operational principleEach channel has its own independent table comprising a numberof entries that describe the frequency, amplitude and phase of the rfoutput at each step. Once the sequence has been defined using the

TABLE,ENTRY or TABLE,APPEND commands (see §C.7), it is readied forexecution using the TABLE,ARM command. The table is checked forerrors, and will fail if an incompatibility is detected.Once the table is armed, execution is started by either a hardwareTTL trigger on the channel’s ON/OFF input or using the TABLE,STARTcommand. The table can be automatically restarted after completionby enabling the TABLE,RESTART option, and execution can be stoppedmid-sequence using the TABLE,STOP command.When a table is armed, the RF is switched on and upon completionof the table the final RF state remains ongoing. If it is required thatthe output be disabled when the table is complete, the final entryshould set the power to 0x0 (zero amplitude, not 0 dBm).A simple example of a table mode shape is shown below with theresulting output demonstrated in Figure 5.1. The channel it putinto table mode and any existing table is cleared. The steps inthe sequence are then added one by one, and the table is armed.Once the arming is complete, the table is executed. Although isit not necessary to separate the “arm” and “start” steps, it can bepreferable to do so to assist in debugging.
25
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MODE,1,TSB

TABLE,CLEAR,1

TABLE,APPEND,1,20MHz,0dBm,0,0x1

TABLE,APPEND,1,50MHz,5dBm,0,0x1

TABLE,APPEND,1,100MHz,10dBm,0,0x1

TABLE,APPEND,1,50MHz,-5dBm,0,0x1

TABLE,APPEND,1,20MHz,5dBm,0,0x1

TABLE,APPEND,1,20MHz,0x0,0,0x1

TABLE,ARM,1

TABLE,START,1

Listing 5.1: Demonstration of simple table mode commands.

Figure 5.1: Output waveform generated by simple table mode example.
Typically more complicated pulse sequences are of interest, such asgenerated shaped envelopes with frequency sweeps. These tablesare often generated by user-created scripts, or as part of a controlsystem.An example of such a pulse is shown in Figure 5.2 where the RFfrequency is swept under a Gaussian envelope. Examples of howto do generate this pulse in several programming languages areprovided in Appendix E.
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Figure 5.2: Demonstration of a more complicated table sequence involvinga shaped pulse with frequency chirp.
5.2 Table entry structureTable entries are defined by:

TABLE,ENTRY,ch,num,[freq,pow,phas,dur,flags]The RF parameters and duration can be specified as integers (defaultto MHz, dBm, degrees) or with appropriate units such as kHz, mW,ms. For duration, the default unit is 5 us; that is, a duration of 2specified without units means 10 us.
5.3 External triggerAn external trigger on the ON/OFF TTL input can be used in tablemode to synchronize with other devices. In this mode the instructionwill be repeated until a falling trigger is detected. Trigger mode isactivated by specifying a duration of zero, or with the TRIG flag.After a table is armed with the TABLE,ARM command, it will automat-ically begin executing upon a falling external trigger on the associ-ated channel’s TTL input. It is therefore typically not necessary touse the TRIG flag on the first table entry for such operation.
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If a trigger is not received, the TABLE,STOP command should be usedto abort operation.If it is preferable to respond to a rising trigger instead of a fallingtrigger, this can be set using the TABLE,EDGE command.The table is executed on a fixed timebase internal clock, so the tablewill continue executing on the first clock “tick” after receiving theTTL trigger. This results in apparent jitter of up to 5µs in respondingthe to trigger. In applications where jitter must be minimised, it ispossible to synchronise the internal clock to the external triggerusing the command TABLE,TIMESYNC,ch instead of TABLE,START,chor TABLE,ARM,ch. The first TTL trigger will reset the timebase and asubsequent trigger will kick off table execution.
5.4 Re-arm and restartThe QRF can be instructed to automatically re-arm the table aftera successful execution using the TABLE,REARM command. This au-tomatically prepares the table for execution from either hardwareor software trigger once execution has finished. A subsequent TTLtrigger will then restart the table execution.Furthermore, the table can be repeated continuously by enablingthe TABLE,RESTART option. This will cause the table to immediatelyre-execute after it has been rearmed, although an initial hardwareor software trigger must be provided to begin the first execution.



A. Specifications

Parameter Specification

RF characteristicsMax output power +33 dBm/+12 dBm (241/041 models)Output impedance 50ΩAmplitude control 10-bit resolutionFrequency 10 to 200 MHzFrequency control 32-bit resolution; 0.116 Hz stepsFrequency stability ±25 ppm (0 to 50◦C)Phase 0 to 2π (14-bit resolution)Phase noise TBDSignal to noise TBDIntermodulationand spurious TBD
Channel crosstalk < −70 dBc (off), < −50 dBc (on)RF off/on < −70 dBm, < 40 ns
Analogue inputInputs 1 per channel (4 total)Function FM, AM, φ or PIDSensitivity ±1 VBandwidth 70 kHz with 2nd order anti-aliasResolution 12-bitInput impedance 5 kΩ
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Digital input (per channel)RF on/off TTL hardwired, positive logic onlyTrigger input TTL input to continue table executionTTL input high 2.2 VTTL input low 0.6 VAbsolute max in 6.5 VAbsolute min in -0.5 V
Table modeMin step time 5µsTiming resolution 5µsMax table length 8191 instructions per channelTrigger options Software, or TTL via rear panel
Mechanical & powerDisplay 320x240 px colour LCDFans 5 x temperature controlled fansIEC input 90 to 264 Vac, 47 to 63HzDimensions W×H×D = 250× 79× 292 mmWeight 2 kg



B. Firmware upgrades

From time to time, MOGLabs will release firmware updates thatenable new functionality or address issues. This section providesinstructions on how to apply firmware updates to your device.
WARNING: Do not attempt to communicate with the device while a firmware upgradeis being applied, and do not interrupt an upgrade (or factory reset) in progress.

B.1 Upgrade via mogrfThe recommended way to install updates is using the “mogrf” ap-plication, accessed through the File menu. Information about thecurrent firmware will be shown and you will be given the option toinstall an update (Figure B.1). Note that the device should not be
used while upgrading firmware.

Figure B.1: The firmware update application connected to a unit, showingthe device information (top) and current firmware versions (middle). Ensurethat the model numbers are correct before continuing.
Update packages are available from the MOGLabs website and areloaded into the application by pressing the “Select” button. Thefirmware in the package is compared against the currently runningversion to determine which upgrades are required.Each component of the firmware is compared against the packageversion and colour coded as follows:31
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Green: Component matches package version and is up-to-date.
Yellow: Package contains an update which should be applied.

Magenta: Package contains an older version than currently installed. In-stalling this component will downgrade the firmware.
Red: Currently installed version conflicts with package version and may bedamaged. Installation of package version is strongly recommended.

Click on Update all to install all detected upgrades in sequence,otherwise individual components can be installed by clicking the
Upload option next to each item.The upload process proceeds through four stages:

1. The FLASH memory is erased to make room for the new image.2. The data is uploaded to the device.3. The device checks the data is received for consistency, to en-sure the upload was successful.4. The device is rebooted to load the new firmware.
The device will reboot after every individual component upgrade,to ensure the upload was successful before moving on to the nextcomponent. The software will automatically try to reconnect to thedevice.

B.2 Factory resetIf a firmware upgrade fails and the device subsequently cannot boot(even with DIP1 set to ON), a factory reset can be applied. Bootingthe device with DIP4 set to ON will then restore the configuration ofthe device as it was shipped. Once complete, the device will displaya message on the front-panel LCD screen requesting that you returnDIP4 to OFF and reset the device.



B.2 Factory reset 33
Note that all device settings will be overridden with factory defaults,including network settings, power limits, frequencies, calibrations,and so on. Ensure that relevant values are corrected after the reset.Once the reset is complete, upgrade can be reattempted to gainaccess to newer features, or a different firmware can be applied.Please contact MOGLabs if you encounter any difficulties duringfirmware upgrade.
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C. Command language

Please note: The command language is being continuously updated across firmwarereleases to improve functionality and add features. When upgrading firmware, pleaserefer to the most recent version of the manual available at http://www.moglabs.com
C.1 Arguments Most commands accept a comma-separated list of parameters, typ-ically including a channel number “ch” (1, 2, 3 or 4). Optional pa-rameters are listed in square brackets. Only the first few charactersof the command name are significant.Units can be specified for physical values as appropriate, namely:

Frequency Hz, kHz, MHz (default)
Power dBm (default), dB, mW, W
Phase deg (default), rad
Time us, ms, s; default is increments of 5 us

Note that when requesting a particular value to change, the actualvalue may differ from the requested value because of discretisationand/or parameter limits. Typically the command will respond withthe closest permitted value.If required, values corresponding to internal representation can bespecified directly using hexadecimal format with a “0x” prefix. Thisis potentially useful for stepping through the discrete values thatthe DDS is capable of generating.All commands respond with a string that begins with either “OK” or“ERR” to indicate whether it was successful. It is strongly recom-
mended that commands be checked for success.

35
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C.2 General functions
REBOOT Initiate microcontroller reset, causing unit to reboot. Note that allcommunications links will be immediately closed.

INFO Report information about the unit.
VERSION Report versions of firmware currently running on device. Pleaseinclude this information in any correspondence with MOGLabs.

TEMP Report measured temperatures and fan speeds.

C.3 Basic control
STATUS STATUS[,ch]Reports the current operational status of the specified channel, de-scribing whether the signal and amplifiers are switched on. Returnsan error if the device is not operational.

MODE MODE,ch[,type]Controls the operational mode of the given channel; type is oneof NSB, NSA or TSB (see §1.1). Note that some options are onlyavailable in particular modes.Note: this command automatically switches off the output of thespecified channel.
OFF/ON OFF,ch[,mode] ON,ch[,mode]Enable or disable the RF output of the specified channel. The signaland amplifiers can be individually controlled, which allows for morerapid switching response (see §4.5). mode is one of:

SIG Turn off/on the RF signal only.
POW Turn off/on the RF high-power amplifier only.Note that the amplifiers take 2 s to completely power on.

ALL Turn off/on both the RF signal and high-power amplifier (default).
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SLEEP SLEEP,dtPause microcontroller operation for dt milliseconds. Intended for usein simple scripts to wait for a short amount of time, e.g. for tables tofinish execution. Note that the microcontroller will be unresponsiveduring this time.

C.4 Primary RF control
FREQUENCY FREQ,ch[,value]Set channel ch to specified frequency as permitted by the DDS’s32-bit frequency resolution.

POWER POW,ch[,value]Set channel ch to specified output power as computed using a factorycalibration. To prevent damaging attached components, a power limitis applied with the LIMIT command.
LIMIT LIMIT,ch[,value]Defines the maximum RF power for given channel ch, with the samesyntax as the POW command. If the limit is set below the currentpower level, the current power is reduced to the limit.

PHASE PHASE,ch[,phase]Set channel ch to have the specified phase offset.
ALIGNPHASE ALIGNPH[,ch] ... [,ch]Simultaneously resets the phase accumulators of the associatedchannels. This may be necessary to re-establish a stable phaserelationship between two channels after their frequencies are ad-justed. If no channels are specified, all channels are simultaneouslyreset.

PHRESET PHRESET[,onoff][,ch] ... [,ch]Enable or disable automatic phase alignment on the given chan-nel(s), which performs an automatic phase alignment after a FREQcommand is issued. This feature may be useful for applications suchas IQ-modulation. If no channels are specified, it applies to allchannels.
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C.5 Modulation

MOD MOD,ch,type[,onoff][,gain]

MOD,ch[,type1][,type2]

MOD,ch,PRI[,type]

MOD,ch,SEC[,type]Enables (or disables) modulation type of a given type (amplitude,frequency, or phase) for the selected channel.
type One of F[REQ] (frequency), A[MPL] (amplitude), P[HAS] (phase) or N[ONE].
onoff Can be ON or OFF. Reports whether this modulation mode is cur-rently enabled if not supplied.
gain Optionally specify gain for this modulation type; equivalent to sub-sequently using the GAIN command.

If two types are specified, dual-modulation is enabled with the givenprimary and secondary modes (§4.3). Alternatively the primary andsecondary modes can be configured separately by specifying PRI orSEC.
GAIN GAIN,ch,type[,gain]Sets the modulation gain for the specified modulation type on thegiven channel. gain is a floating-point number with units or a signedhexadecimal integer that controls the depth of the modulation (§4.2).If gain is negative then the modulation action is inverted.

MAPMOD MAPMOD,ch[,pri,sec]Configures the primary and secondary modulation inputs for thespecified RF channel (see §4.3). The parameters pri and sec are 1–4corresponding to the associated numbered input on the back-panel,or “*” for no change. Note that changing the modulation mappingmay disable modulation on those channels, after which they mayneed to be re-enabled.
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C.6 Clock referenceThe DDS operates from an internal clock (SYSCLK) at 500MHz, whichis derived either from the on-board crystal oscillator at 25 MHz (“in-ternal” mode) or from the back-panel SMA input labelled CLK IN (“ex-ternal” mode).The DDS can only accept a limited range of reference frequencies,including 25 MHz, 50 MHz, 100 MHz, 125MHz and 500 MHz, but

not 10 MHz. In applications where minimal phase noise is critical,it is recommended to directly supply a stable 500MHz reference torun the SYSCLK without the PLL engaged1.
CLKSRC CLKSRC[,source][,freq]Query or set the current clock source. source is either INT to usethe internal 25MHz oscillator, or EXT to use the reference providedto the CLK IN connector. When using EXT mode, the parameter freqmust be the frequency in MHz. An error will be generated if theclock frequency is not supported. Specifying the freq as either zeroor 500 will disable the DDS’s PLL and it will clock directly from theprovided signal.Configuring an external clock but not providing a stable clock signalresults in undefined behaviour. It is strongly recommended that theexternal clock signal be provided before powering on the device.

Note: The external reference clock must have power between 0 dBm and +5 dBm.
Never operate the QRF in external clock mode without providing a valid reference
clock, as undefined behaviour can result.

1Available in Rev3+ hardware only
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C.7 Table mode Table mode gives access to the powerful sequencing functionality ofthe QRF devices (chapter 5). The syntax is compatible with ARF/XRFdevices where applicable.
STATUS TABLE,STATUS,chReports the current execution status of the table.
CLEAR TABLE,CLEAR,chStops and clears the table entries from the specified channel.
ENTRY TABLE,ENTRY,ch,num,[freq,pow,phas,dur,flags]Configure the specified table entry. If only ch and num are given, thecurrent entry of the table is returned.

ch The channel to edit.
num The entry to edit (1 to 8191).
freq Frequency to output during this step.
pow Output power during this step.
phas Phase offset of the RF for this step.
dur Duration of this step, discretised at 5 us; that is, 1 gives 5 us dura-tion, 2 gives 10 us, etc. Can be specified in us, ms or s, with maximumduration 83s. If zero, the entry is held until a hardware trigger isreceived.

flags A comma-separated list of flags.
SIG Switch off the RF signal for this step, disabling the output. Mustbe repeated in subsequent steps for the signal to remain off.

POW Switch off the RF power amplifier for this step, disabling theoutput. Must be repeated in subsequent steps for the signal toremain off.
TRIG Equivalent to setting duration to 0; that is, wait for externaltrigger.



C.7 Table mode 41
HEXENTRY TABLE,HEXENTRY,ch,numQueries the specified table entry, returning the internal hexadecimalrepresentation of the associated frequency, amplitude and phase.

ENTRIES TABLE,ENTRIES,ch[,num]Alternative: TABLE,LENGTH,ch[,num]Defines the last table entry number for the given channel. Incorrectlysetting the number of entries can result in undefined behaviour.
APPEND TABLE,APPEND,ch,freq,ampl,phase,duration[,flags]Inserts the specified entry at the end of the table and incrementsthe TABLE,ENTRIES counter.

COPY TABLE,APPEND,src,destCopies the table data from the src channel to the dest channel.
NAME TABLE,NAME,ch,[‘‘name’’]Assigns a character string to the table for identification purposes.Use quotation marks to preserve case.

ARM TABLE,ARM,ch[,...]Loads the table for execution and readies the output. The table thenbegins execution upon receiving a software trigger (TABLE,START)or hardware trigger on ON/OFF input. Multiple channels can bespecified to arm them simultaneously.
START TABLE,START,ch[,...]Provides a software trigger to initiate table execution. Multiplechannels can be specified to start them simultaneously.

TIMESYNC TABLE,TIMESYNC,chSynchronise internal clock to the external trigger on the specifiedchannel. The first trigger will reset the timebase and a subsequenttrigger will initiate table execution. Use instead of START or ARM.
STOP TABLE,STOP,ch[,...]Terminates an executing table at the end of the current step. Mul-tiple channels can be specified to stop them simultaneously.
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REARM TABLE,REARM,ch[,on/off]Enables/disables the automatic re-arming (loading) of the tableupon completion such that it can be started again from a hardwareor software trigger.
RESTART TABLE,RESTART,ch[,on/off]Enables/disables an automatic software-controlled restart of the ta-ble upon completion.

EDGE TABLE,EDGE,ch[,mode]Sets the TTL trigger edge for the table as either RISING or FALLING.
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C.8 PID feedbackThe QRF has an integrated PID-controller that can feed back to theamplitude, frequency or phase of the RF output in response to anerror signal (see §4.4).

ENABLE PID,ENABLE,ch,modeEnables the PID controller for the given channel in the specified
mode, which is one of FREQ, AMPL or PHAS.

DISABLE PID,DISABLE,chDisables the PID controller for the given channel.
STATUS PID,STATUS,chReports the current status of the PID controller and whether satura-tion occurred. The saturation flag is reset by this query.

SETPOINT PID,SETPOINT,ch[,val]Applies a DC offset to enable locking to a non-zero set-point voltage.If specified, the voltage val must be between -1 and +1V. Note thatthe lock may become unstable close to these limits due to clippingof the error signal.
INVERT PID,INVERT,ch[,on/off]Inverts the controller action for the given channel.

GAIN PID,GAIN,ch,name[,value]Sets the PID gain constant for name, which is one of P (proportional),
I (integral) or D (derivative). value is a floating point number in therange [0,1]. The derivative gain can be negative, which inverts thesense of the derivative action with respect to the other components,and may be beneficial in some applications that require phase leador lag.

ERROR PID,ERROR,chReturns the value of the error signal fed into the PID control loop,for diagnostic purposes.
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C.9 Ethernet settings
INFO ETH,INFOReports current ethernet settings.

STATUS ETH,STATUSReport the status of the ethernet connection.
WEB ETH,WEB,onoffEnable or disable the integrated web server for device control.

STATIC ETH,STATIC,ipaddrSet IP address based on the supplied dotted-quad string (for example”10.1.1.180”). The static address is used if DHCP fails, or is disabled.
MASK ETH,MASK,ipmaskSet IP mask based on dotted-quad string (for example ”255.255.255.0”).

GW ETH,GW,ipaddrSet IP gateway based on dotted-quad string (for example ”10.1.1.1”).
PORT ETH,PORT,portSet the TCPIP port number for device communication.
DHCP ETH,DHCP,onoffEnable or disable DHCP.



D. Communications

The QRF can be connected to a computer by USB or ethernet (TCPIP).The software package mogrf (chapter 3) provides interactive func-tionality. Device control can also be integrated into existing con-trol software following the protocol below using the commands inAppendix C. A detailed connection guide is available from theMOGLabs website.
D.1 Protocol Device communication follows a query/response protocol using CRLF-terminated ASCII strings. Statements are either commands or queriesdepending on whether they cause an action to occur. A commandwill always respond with OK or ERR depending on whether the actionsucceeded.It is strongly recommended that all software should wait for thisresponse and check for success before continuing. The python and

LabVIEW bindings provided take care of buffering and error checkingautomatically.The MOGLabs Device Commander application is available as part ofthe mogrf package and provides a convenient interface for sendingcommands and receiving responses (see §3.2).
D.2 TCP/IP The QRF can be accessed over ethernet via the IPv4 protocol. Whenethernet is connected, the QRF will attempt to obtain an IP addressby DHCP. If DHCP fails, an internally defined address will be used.In both cases, the address will be shown on the device display (forexample, 10.1.1.190:7802), showing the address and port numberfor communicating with the device.

45
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D.2.1 Changing IP addressDepending on your network settings you may need to manually setthe IP address. This is most easily done via the front-panel interfaceas detailed below.
1. From the main menu, open Options > Ethernet Settings.2. Select Static IP and use the encoder wheel to set the IP ad-dress of the device as required. Pressing the encoder wheelchanges between octets of the address.3. Select Gateway and set the gateway address as required.4. Select DHCP and set to OFF by turning the encoder anti-clockwise.5. Select Restart ethernet and press the OK button.6. The new IP address will be displayed in the display footer.

In some situations it may be necessary to power-cycle the device topropagate ethernet changes.
D.3 USB The QRF can be directly connected to a host computer using a USBcable (type A-male). The device will appear as a Virtual COM port,which behaves like an RS232 connection. The required STM32 VirtualCOM Port Driver (VCP) device driver is available from the MOGLabswebsite for the WindowsTM operating system. After installation, theQRF will appear as a COM port on the machine.To determine the port number of the device, go to Device Manager(Start, then type Device Manager into the Search box). You shouldsee a list of devices including Ports (Figure D.1).



D.3 USB 47

Figure D.1: Screenshot of Device Manager, showing that the QRF canbe communicated with using COM4. The port number might change whenplugging into a different USB port, or after applying a firmware update.
The device can be identified as a COM port with the following name,

STMicroelectronics Virtual COM Port (COMxx)where xx is a number (typically between 4 and 15). In the exampleabove, the device was installed as COM4.Note that if the port appears in Device Manager with a differentname, then the driver was not successfully installed. If this occurs,disconnect the device from the host computer, reinstall the VCPdriver, then reconnect the USB cable.
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E. Code examples

MOGLabs devices use standard protocols, allowing control from anyprogramming language with appropriate standard libraries for net-work or serial communication. The following simple examples demon-strate how to communicate with the QRF over ethernet in severallanguages, using the helper bindings provided by MOGLabs.
E.1 python Communication is handled by a “device” class, which provides con-venience functions for sending commands and queries. The followingexample shows how to construct a Gaussian pulse using numpy andthe MOGDevice class, with the resulting waveform shown in Fig-ure E.1.#======================================# Gaussian pulse example, (c) MOGLabs 2020#======================================

from mogdevice import MOGDevice

import numpy as np# connect to the device
dev = MOGDevice(’192.168.1.20’)

# construct the pulse
N = 250 # number of points to generate
X = np.linspace(-1,1,N)

P = 5 - 35*X**2 # Gaussian amplitude, =30 to +10dBm
F = 100 + 50*X # linear sweep, 50 to 150 MHz
dev.cmd(’MODE,1,TSB’) # set CH1 into table mode
dev.cmd(’TABLE,CLEAR,1’) # clear existing table
for (f,p) in zip(F,P): # upload the entries

dev.cmd(’TABLE,APPEND,1,%.2f,%.2f,0,1’%(f,p))

dev.cmd(’TABLE,START,1’) # execute the table
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Figure E.1: Pulse with a Gaussian envelope, created in table mode usingthe example python code.
E.2 matlab Similar to the python bindings, a device class is provided to makecontrolling the QRF easy using matlab. The listing below demon-strates how to generate the previous example in matlab.%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%% MATLAB pulse example, (c) MOGLabs 2020%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%% create a device instance

dev = mogdevice();% example: connecting by ethernet
dev.connect(’10.1.1.31’);% print some information about the device
disp(dev.ask(’INFO’));

% create a gaussian envelope
N = 250;

X = (1:N)/(N/2) - 1;

P = 5 - 35*X.^2;

F = 100 + 50*X;

% upload gaussian pulse in simple table mode
dev.cmd(’MODE,1,TSB’);

dev.cmd(’TABLE,CLEAR,1’);

for i=1:N
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% we can use printf notation when sending commands
dev.cmd(’TABLE,APPEND,1,%f,%f,0,0x1’,F(i),P(i));

end

disp(’Done’)

dev.cmd(’TABLE,ARM,1’)

dev.cmd(’TABLE,START,1’)

% close the connection
delete(dev);

E.3 LabVIEW The LabVIEW drivers provided make use of NI-VISA to provide aunified interface over both ethernet and USB. They perform automaticerror checking, and are compatible with LabVIEW-2009 and latereditions.

Figure E.2: Example LabVIEW program that connects to an QRF unit, andperforms a number of queries
When using these drivers, it is strongly recommended that the au-tomatic session close option be enabled, to prevent communicationsproblems if the VI aborts or is interrupted. The option is found inTools→Options→Environment→Automatically close VISA sessions.
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